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USB to RS-422 / RS-485 Adapter

Introduction

This Adapter is designed to make massive data communication become quick and simple through
an USB port of PC. By taking the advantage of the feature of USB port and Serial port, it provides
an easier and more convenient connectivity than ever for efficient and friendly interaction between
RS-422 or RS-485 devices and your computer systems.

The interface of RS-422 and RS-485 are very common adopted in data acquisition world. Both
standards feature reliable performance of full-duplex or half-duplex multi-drop communication
network with faster data rates and longer communication distance than RS-232. Application
devices include telecommunication units, LAN, data concentration, data multiplexers, ISDN, POS,
industrial controls, etc.

System Requirements

Windows : 98SE / Me / 2000/ XP / Vista/7/8/8.1/10/ 11; Windows Server 2003 / 2008 / 2008R2 /
2012/ 2012R2 /2016 / 2019

WinCE :V4.2~V7.0

Mac OS :8.x/9.x/10x/11

Linux : Kernel 1.5.0 or above

The system is equipped with USB Host Controller

VVVY 'V

Features

Reliable performance of full-duplex or half-duplex multi-drop communication

Fully compliant concurrent operation

Plug and play and hot-swapping

15KV ESD Protection

Supports data transmission at high rates over long distance (4,000ft.)

Supports devices include telecommunication units, LAN, data concentration, data multiplexes,
ISDN, POS, industrial controls, etc.

Specification:-

DB-9 Connector

Model No. UTS-422XS | UTS-485XS | UTS-M12XS
Chipset FTDI
Interface RS-422 | RS-485 | RS-422/RS-485
Compliant USB Version USB 1.1 &2.0
Data transfers rate 300 to 3M baud
Mode Selection | Slide Switch
Connector Upstream USB A Male

Device DB-9 Male | DB-9 Male x 2
Power Mode Bus Powered
Cable Length 1.1m 0.6m
Housing PVC Molding Plastic
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Terminal Block Connector

Model No. UTS-422TBXS | UTS-485TBXS
Chipset FTDI
Device Interface RS-422 | RS-485
Compliant USB Version USB1.1&20
Data transfers rate 300 to 3M baud
Connector Upstream USB A Male
Device 5 Pin Terminal Block
Power Mode Bus Powered
Cable Length im
Housing Plastic

RJ-11 Connector

Model No. UTS-200J2XS | UTS-20035XS | UTS-200IXS
Chipset FTDI
Device Interface RS-422 | RS-485 | RS-422/RS-485
Compliant USB Version USB1.1&2.0
Data transfers rate 300 to 3M baud
Selection Mode | Slide Switch
Upstream USB A Male
Connector -
Device RJ-11 6P4C Female x 2
Power Mode Bus Powered
Cable Length im
Housing Plastic

LED light Indication

Power/Link--- unit is ready for use.
RX---Receive Data (Data is being sent from RS-422 or RS-485 device to USB port)

TX---Transmit Data (Data is being sent from USB port to RS-422 or RS-485 device).

PIN Assignments
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DB-9 Male Connector

RS-422(DB-9M) RS-485(DB-9M)

i)
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I+

Description Pin# Description

TX-
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RX+
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UTS-422TBXS UTS-485TBXS

RX TX 2 1

G G
- + - + - + -

5 4 3 2 1 5 4 3 2 1
Pin# | Definition Description Pin# | Definition Description
1. TX+ 1. D+

TX 1
2. TX- 2. D-
3. RX+ 3. D+

RX 2
4, RX- 4, D-
5. G GND 5 G GND
1 TX+ 0—’. RX+ 3 1. D+ e D+ 1

2 D- oo D- 2
2 TX- o—‘o RX- 4
D+ 3 |le—el D+
3 RX+ ._F TX+ 1 D- 4 (e—@2 D-
4 RX- 0—’. TX- 2 3 D+ ®&® D+
4 D- —e D-

5 GND 0—" GND 5

UTS-485TBXS
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Termination Resistors :

Termination Resistor

UTS-485TBXS 120 O
Jumper Pin J1 Function Status
Setting Jumper Plugged ON (Default)
Setting Jumper Un-Plugged OFF
Loopback
UTS-485TBXS Loopback
Jumper Pin J6 J7 Function Status
. Jumper Jumper
Setting Plugged Un-Plugged OFF (Default)
. Jumper Jumper
Setting Un-Plugged Plugged ON

RJ-11 Connector

6
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RS-422

Select only one socket to connect cable

3 N

RS-485

Series connection possible

~

\ . \
RX Power TX | | m ’ ] "X Power T | \ ' l
‘.-asm { . RSAab ]
1

_— PiNG  Pint | e PinG  Pin1
|\_ e S _/ |\_4,_b-
RS-422 (Full Duplex Mode)
PIN2 : RX+
PIN3 : RX-
PIN4 : TX-
PIN5S : TX+
APoint to Point:
RJ-11 RJ-11
TX+ | 5 5 TX+
PC# 1 T™X- | 4 4 | TX- | PC#2
RX+ | 2 2 RX+
RX-| 3 3 RX-
RS-485 ( Half Duplex Mode)
PIN4 : D -
PIN5 : D+
APoint to Point:
PC#1 | p+ 5 5| D+ PC# 2
R\]'ll D' 4 D_ R\]'ll
AMulti-Drop:
RJ-11 | D- 4 4 | D- RJ-11
5 4 5 4
PC#2 | p+ D+ PC# 3
RJ-11 | D- D- RJ-11

UTS-200JXS / UTS-200J5XS




USB to RS-422 / RS-485 Adapter
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Termination Resistors :

UTS-200XS / UTS-2005XS Termination Resistor
120 Q
Jumper Pin J1 J2 Function Status
. Jumper Jumper
Setting Plugged Plugged ON (Default)
. Jumper Jumper
Setting Un-Plugged | Un-Plugged OFF
Loopback
UTS-200JXS / UTS-200J5XS Loopback
Jumper Pin J6 J7 Function Status
. Jumper Jumper
Setting Un-Plugged Plugged OFF (Default)
. Jumper Jumper
Setting Plugged UN-Plugged ON

Note: Termination Resistors / Loopback alteration available for models shown only.
Please do not remove jumpers on other Models to avoid malfunction.
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Windows OS Installation Guide

Driver can be installed through Windows Update automatically (Internet connection needed)

The FTDI drivers that have passed the WHQL tests are available for download using Windows Update.
OS requirements: Windows 7/8/8.1/10/11

Please go below ways for easy installation.

1. You may plug the device into host computer. And then it will pop up ‘Installing device driver software’ from
the taskbar of the screen. (Fig. 1) Click and connect to the Windows Update.

2. It will check your computer OS and download the applicable driver at the Windows Update automatically.

Installing device driver software * *
Click here for status.

Fig. 1

3. The program goes ‘Searching Windows Update’ from ‘Driver Software Installation’. (Fig. 2)

17 Driver Software Installation’

Installing device driver software

Generic USB Hub E
USB <-> Serial {_J Searching Windows Update...

Obtaining device driver software from Windows Update might take a while.
Skip obtaining driver software from Windows Update

Fig. 2

4. When the applicable driver is detected, it will run ‘Installing device driver software’. (Fig. 3)

-
| Driver Software Installation

Installing device driver softwagg,

USB <-> Serial | {_/Searching preconfigured driver folders... I

Fig. 3




USB to RS-422 / RS-485 Adapter

5. Then it shows ‘USB Serial Port (COMS8) installed’. Click ‘Close’ and go next step. (Fig. 4)

-
_J Driver Software Installation

Your device is ready to use

-
USB Serial Converter «/ Ready to use
USB Serial Port (COMS8) / Ready to use

Fig. 4

6. Check ‘Device Manager’ of Control Panel from the computer OS and there shows USB Serial Port (COMB8)
under ‘Ports (COM & LPT)’; the other one shows USB Serial Converter under ‘Universal Serial Bus
controllers’. (Fig. 5) Congratulation! You have finished installing the USB to Serial device successfully.

2 Device Manager I oo o)
File Action View Help

e AN RENN ? ol AN ¢

> ¥ Network adapters -
b K} Portable Devices

4 Y7 Ports (COM & LPT)

Processors
» % Sound, video and game controllers
' ; M System devices
4 | Universal Serial Bus controllers
§ Generic USB Hub
Generic USB Hub
Generic USB Hub
USB Root Hub
USB Root Hub
USB Root Hub
USB Root Hub
USB Root Hub
USB Root Hub

sf sL BE =L =L sL 8L s &l =

m

B Camde e eI N/ T LICD P | P

Fig. 5

NOTE: It may occur when driver is not installed successfully, please check below steps.
1. There is busy on access databank of Microsoft’s Support link. Please try again or install driver of CD-ROM

provided.

2. Check your internet if it is failed to access Microsoft's Support link.
3. Check your computer configuration if it is disabled on Windows Update wizard.

Device driver software was not successfully installed
Please consult with your device manuffficturer for assistance getting this deviclinstalled.
USB <-> Serial ¢ No driver found

What can I do if my device did not install properly?

Close

10
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Driver Installation thru the FTDI Driver Package

Driver can be installed through the FTDI driver package of the CD-ROM provided.

1. Double click ‘Setup_v2.12.00 WHQL Certified For Windows OS_x86.x64.exe’

-~

E

)

).
Linux(1.5.0) Mac OS 8.9

\ f
Windows CE Windows RT
4.2-5.2 6.0_Mo
bile

2003,2003SE,5...

|

Windows
2000(2.06.00)

é

Windows
98ME(1.09.06)

Mac OS X 10.9
and above(2.3)

XP,2003,Vistaf0 | Setup_v2.12.00

; For Windows
0) OS_x86.x64 exe

2. It will pop up ‘FTDI CDM Drivers’ from the screen. Click ‘Extract’ and go next step.

r

FTDI CDM Drivers

=)

Click 'Extract’ to unpack version 2,12.00 of FTDI's Windows
driver package and launch the installer.

wwnw ftdichip.com

Extract

Cancel

11
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3. Extracting Files

_
@ FTDI CDM Drivers [

Extracting Files
FreeExtractor is extracting the compressed files in this archive.

Please wait while the files in this archive are extracted.

Extracting Static/i386/ftd 2xclib ...

4. Click ‘Next’ to continue.
- _
Device Driver Installation Wizard

Welcome to the Device Driver
Installation Wizard!

Thig wizard helps you install the software drivers that some
computers devices need in order to wark.

To continue, click MNext.

12
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5. Select ‘I accept this agreement’ and click ‘Next'.

Device Driver Installation Wizard

i_ License Agreement

To continue, accept the following license agreement. To read the entire
= agreement, use the scroll bar or press the Page Down key.

IMPORTANT MOTICE: PLEASE READ CAREFULLY BEFORE -
IMSTALLING THE RELEVANT SOFTWARE: |:|
This licence agreement (Licence)is a legal agreement between you
(Licensee aryou) and Future Technology Devices Intemational Limited

of 2 Seaward Place, Centurion Business Park, Glasgow G41 1HH,
Scotland (UK Company Mumber SC136640) (Licensor ar we) for use of
driver software provided by the Licensor{Software).

BY INSTALLING OR USING THIS SOFTWARE YOU AGREE TO THE -

’ Save As ] [ Pririt

@ i accept this agreement!
) | dont accept this agreement

<Back || Net> ||| Cancel

6. The Device Driver Installation Wizard will detect your computer OS and install the applicable driver

automatically.
Device Driver Installation Wizard

The drivers are now installing....

s

e, -,

Please wat while the drivers install. This may take some time to complete.

13
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7. While the Device Driver Installation Wizard is completing, click ‘Finish’ to exit.

Device Driver Installation Wizard

Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer.

You can now connect your device to this computer. f your device
came with instructions, please read them first.

Driver Name Status

w* FTOI COM Driver Package - Bus/D2X... Readyto use
w* FTDI COM Driver Package - VCP Driv... Readyto use
€ 1

I Cancel I

Windows 98SE Installation Guide

If a device of the same type has been installed on your machine before and the drivers that are about to be
installed are different from those installed already, the original drivers need to be uninstalled. Please refer to
the uninstalling instruction.

Download the latest available drivers from the FTDI website and unzip them to a location on your PC.

Connect the device to a spare USB port on your PC. This will launch the Windows Add New
Hardware Wizard. Windows may display a message reading "Building driver database" at this point

which may take a few minutes to pass. Click "Next" to proceed with the installation.
Add New Hardware Wizard

This wizard searches for new drivers for:

USB <-> Serial Cable

A device driver is a software program that makes a
hardware device work.

Cancel

14
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Select "Search for the best driver for your device. (Recommended)." as shown below and then click "Next".

Add New Hardware Wizard |

Whal do you want Windows to dao?

« Search for the best driver for your device.
{Recommended).

" Display a list of all the drivers in a spectic
location, so you can select the driver you want,

< Back Next > Cancel

- Check the box next to "Specify a location" and uncheck all others as shown below. Click "Browse" and
locate the driver files. Once the files have been located, click "Next" to proceed with the installation.

Add New Hardware Wizard

‘windows will search for new drivers in its diver database
on your hard drive, and in any of the follownag selected
locatons. Click Next to start the search.

™ Hoppy disk drives
[~ CD-ROM drive
[ Microsoft Windows Update

IV Specify a location:
|C:\ L]
Browse... I

< Back I Next > I Cancel I

15
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Windows may display a message reading "Building driver database" at this point which may take a
few minutes to pass. Once Windows has found the required files, click "Next" to install the device.

Add New Hardware Wizard I

Wincows driver file search for the device:

USE Serial Converter

Wincows is now ready to install the best diver for this
device. Click Back to select a different driver, or click Next
to continue.

Locaion of driver:

=) C:AWCPDRIT1AFTDIBUS.INF

If the driver being installed does not have Microsoft WHQL signature files (.CAT files), the wizard will request a
driver disk to attempt to find them. Click "OK" on the "Insert Disk" message box.

Insert Disk |

Q Please insert the dis< labeled 'FTDI USB Drivers Disk', and then click OK.

The following window will appear to assist in locating the file. To proceed with the installation without the .CAT
file, click "Skip File".

The file 'ftdibus.cat on FTD| USB Drivers
g Disk cannot be found.

Cancel

Insert FTDI USB Drivers Disk in the selected
drive, and click OK.

Skip File

Details...

Cooy files from:

C:AWCP Drivers LI Browse...

IRE

If the driver being installed is Microsoft WHQL certified, then the .CAT files will be located with the
16
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other driver files and should be installed automatically.

Windows should then display a message indicating that the installation of the serial converter driver
was successful. The COM port emulation driver must now be installed. Click "Finish" to complete the
installation of the serial converter and proceed to the COM port emulation driver.

Add New Hardware Wizard

@ USB Serial Converter

Windows has finished installing the software that your new
hardware device requires.

Cancel I

Under Windows 98SE, the COM port emulation driver will be automatically installed from the same location
as the serial converter driver. However, if the driver is not WHQL certified as explained above for the serial
converter driver, the wizard will ask for the location of .CAT files. Click "OK" on the "Insert Disk" message

box.

|

Insert Disk

Q Please insert the dis< labeled 'FTDI LUSB Drivers Disk', and then click OK.

The following window will appear to assist in locating the file. To proceed with the installation without the .CAT
file, click "Skip File".

17




USB to RS-422 / RS-485 Adapter

The file 'ftdiport.cat on FTD | USB Drivers
Disk cannot be found.

Cancel
Insert FTDI USB Drivers Disk in the selected
drive, and click OK.

Skip File

Cooy files from: Details...

C:\VCP Drivers

Browse...

H

o |

IEE

If the driver being installed is Microsoft WHQL certified, then the .CAT files will be located with the other
driver files and should be installed automatically.

Open the Device Manager (located in "Control Panel\System" then select the "'Device Manger" tab) and
select "View devices by type". The device appears as an additional COM port with the label "USB Serial

Port".

System Properties | 7] %]

Generdl Device Manager lHard»are Profiles | Perfomancs |

% View devices by type

" View device: by connection

#-@2 Keyboald A
# @ Modem
i 2 Moritoes
BTy Mouss
i1 < MutiOControler
4 39 Network adapters
= J Porte ([COM & LPT)
. Commurications Port (COM1)

- PCIECP/EPP Port (LPT1)
7 PCl Serial Pad (COM2)

4] 1010 18 paadts pan s nirolers
[+ W Systern devices
+ Unwversal Serial Bus controllers
# Unwversal Serial Bus contiollers =
Propestias I Refrezh I Remave I Prnt.. I
I NnK I Canrel I
Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e.
you have to repeat this installation procedure 2 times (2-port converter) or 4 times (for

4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download
the updated or appropriate versions from FTDI Web site
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)”.

18
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Uninstalling Instruction
To uninstall drivers, follow the instructions below:

Disconnect any devices that are attached to the PC.

Open the Add/Remove Programs utility located in "Control Panel\Add/Remove Programs". Select "FTDI
USB-Serial Converter Drivers" from the list of installed programs.

Add/Remove Programs Properties

Install/Uninstall l Windows Setup | Startup Disk |

To nstall a new program from a floppy disk or CD-ROM
; = drive, click Install.

Install...

77 Thefollowing software can be automaticall removed by

o Wirdows. To remove a program or to modily its installed
components, select it from the list and click
Add/Remove.

Chinese [Traditional] Language Supy
FTDI LUSE-to-5Senal Converter Drivers
GetRight

InstantCD/DVD —I
Internet Explorer 0828750

Japanese Language Support

KemelDriver

Key Drive 1.0

Korean Language Support Ll

Add/Remove... |

oK Cancel | Aol

Click the "Add/Remove" button. This will run the FTDI uninstaller program. Click "Continue" to run the

uninstaller or "Cancel" to exit.

FTDI Uninstaller v3.0 ]|

Continue |

If your USB device is connected, please unplug it now. ..

Press Continue to uninstall the drivers, or Cancel to quit.

19
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When the uninstaller has finished removing the device from the system, the caption on the "Cancel" button will
change to "Finish". Click "Finish" to complete the process.

FTDI Uninstaller v3.0 ]|

Uninstalling YID_0403&PID_6001

Deleting registiy entries...
Deleting files...

Uninstall complete. press Finish to exit.

[Eontmue |

20
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Troubleshooting

1. Windows 98SE cannot find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the
INF files for the driver. The VID and PID programmed into the device EEPROM may be found by using the
USBView utility from the FTDI website. These can then be checked against the VID and PID entries in the
driver INF files. If they do not match, that driver cannot be installed the VID and PID entries in the driver INF
files. If they do not match, that driver cannot be installed for that device without either re-programming the
device EEPROM or modifying the list of VID and PID numbers in the INF files. Please note that only your own
company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by your company should be used
in the EEPROM and INF/INI files.

2. Windows 98SE forces areboot after installing a device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy it.
This usually occurs with the FTD2XX.DLL file. If installing a D2XX device, selecting not to restart the computer
then unplugging and re-plugging the device may allow the device to function properly without restarting.
Restarting the machine will allow the device to work correctly.

3. Driver installation fails and Windows 98SE gives error code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a
device has insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices), or
may indicate a more serious hardware problem. Also, it may be indicative of USB root hub drivers being
incorrectly installed. Please refer to the example schematics on the FTDI website for standard device
configurations. If the error persists, please contact the FTDI support department.

4. Windows 98SE complains about missing .CAT files

Files with the .cat extension are signature files issued by Microsoft that indicate a device driver is WHQL

certified. If a driver is not certified, there will be no .cat files available.

When installing drivers in Windows 98SE or Windows ME, the user is prompted to locate the .cat files if the
operating system cannot find them. If the driver is not certified but you wish to install it anyway, the files may
be skipped by clicking the "Skip" button.

5. Windows 98SE complains about missing ftccomms.vxd file
This can occur when the USB Composite driver has been installed if the user has not browsed to the location

of the driver files. If this message appears, do not skip it but browse to the driver file location. The wizard will
then be able to correctly install the device.

21
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Windows 2000 Installation Guide

If a device of the same type has been installed on your machine before and the drivers that are about
to be installed are different from those installed already, the original drivers need to be uninstalled.
Please refer to the uninstalling instruction.

Download the latest available drivers from the FTDI web site and unzip them to a location on your
PC.

Connect the device to a spare USB port on your PC. Once the composite driver has been installed
the Found New Hardware Wizard will launch. Click "Next" to proceed with the installation.

Found New Hardware Wizard

Welcome to the Found New

‘g\ Hardware Wizard
Ny

This wizard helps you instal a device driver for 2
hardware device.

To continue, click Next.

Select "Search for a suitable driver for my device (recommended)" as shown
below and then click "Next".

22
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Found New Hardware Wizard N

Install Hardware Device Drivers g
A devic diiver is a software program that enables a hardware device to work with \?
an operating system.

£

This wizard will complete the installation for this device:

@ USB <-> Serial Cable

A device driver is a software program that makes a hardware device work. Windows
needs diver files for your new device. To loz ate driver files and complete the
installation click Next.

What do you want the wizard to do?
¢ Search for a suitable driver for my device (recommended)

" Display a list of the known drivers for this device so that | can choose a specific
driver

< Back I Nest > I Cancel

Check the box next to "Specify a location" and uncheck all others as shown below. Clicking "Next" displays a
dialog box for you to enter to the location of the drivers.

Found New Hardware Wizard i

Locate Driver Files
Where do you want Wincows to search for driver files? \§

3

Search for driver files for the following hardware device:

@ USB <-> Serial Cable

The wizard searches for suitable drivers in its driver database on your computer and in
any of the following optional search locatiors that you specify.

To startthe search, click Next. If you are searching on a floppy disk or CD-ROM drive,
insert the floppy disk or CD before clicking Next.
Optional search locations:

I Floppy disk drives

[ CD-ROM drives

¥ Specify a location

[~ Microsoft Windows Update

< Back I MNest > I Cancel

23
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Found New Hardware Wizard E l]

Insert the manufacturer's installation disk into the drive K
g selected, and then click OK.

i

Cancel

Copy manufacturer's files from:

[C:ACDM 2.00.00 x| | Browse.. |

Click "Browse" to display an open file dialog box.

Look in: | =y COM 2.00.00 ~| « & ckE-

=] FToIBUS. INF
%] FTDIPORT.INF

%\‘

My Documents

=

e

My Computer
e
==

My Network P...

File name: IFTDIBUS.INF Z‘ | Open I
Files of type: |Setup|nformation {*.inf] LI Cancel I

Locate the folder containing the latest drivers downloaded from the FTDI web site above and click "Open",
then click "OK". The PC auto selects the correct INF file, in this case FTDIBUS.INF.

Once Windows has found the required driver .INF file, click "Next" to proceed.
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Found New Hardware Wizard .

Driver Files Search Results g
The wizard has finished searching for driver files for your hardware device. \?

24

The wizard found a driver for the following cevice:

@ USB <-> Serial Cable

\Windows found a driver for this device. To nistall the driver Windows found, click Nest.

‘5 c:hedm 2.00.00%tdibus.inf

< Back I Nest > I Cancel

Windows should then display a message indicating that the installation was successful. Click "Finish" to
complete the installation for the serial converter driver for this port of the device. The COM port emulation
driver must be installed after this has completed.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

S

3§

AN USB Sernal Converter

Windows has finished installing the software for this device.

To close this wizard, click Finish.

¢ Back I Finish I Eancel
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By examining the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and
click "Device Manger...") and viewing by connection ("View > Devices by connection”), the device appears
as a "USB Serial Converter" with an additional COM port with the label "USB Serial Port".

=10l x|
| acton yew || &= =» | 2@ 2| A

%) @ Intel(R) 82801€6 LPC Interface Controller - 2400 -l

= E Intel(R) 82801EB PCI Bridge - 244E

- HY Intel(R) PROJ100 VE Network Conneciion
B9 Realtek RTLE139/310x Family Fast Ethernet NIC

i Q Intel(R) 82801EB SMBus Controller - 24D2

+-53 Intel(R) 82801EB Ukra ATA Storage Controlers

&2 Intel(R) 82801EB Ukra ATA Storage Controbers

& S Intel(R) 62601EB USE Universal Host Cortroller - 2402
Intel(R) 82801EB 1USB Universal Host Cordroller - 24D4

1 JO Intel(R) 8280158 USE Universal Host Cordroller - 24D7

= Q USE Serial Converter
i ,_y‘ US8 Serial Port (COM3)
+ o n 2N o T0
+ @ Intel(R) 82865G Graphlcs Controller
Intel(R} 82865G\PEIP Processor to IfO Centroler - 2570
Q— Realtek AC'97 Audio
-1 cystem board

Controller - 24DE

&Y Audio Codecs LiC
- Legacy sudio Drivers
- Legacy \ideo Capture Devices

i ™ | cqical Dsk Manager

i % Media Ccntrol Devices L'

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e.
you have to repeat this installation procedure 2 times (2-port converter) or 4 times (for

4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download
the updated or appropriate versions from FTDI Web site
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling Instruction

When uninstalling devices from Windows 2000, it should always be done through the Add/Remove Programs
utility as this uses the FTDI driver uninstaller program to remove files and registry entries to leave a clean
system. Other methods may leave fragments of the driver that may interfere with future installations.

Disconnect any devices that are attached to the PC.

Open the Add/Remove Programs utility located in "Control Pane\Add/Remove
Programs ".Select "FTDI USB Serial Converter Drivers" from the list of installed programs.

ol
El i

computer, click Change/Remove.

Click the "Change/Remove" button. This will run the FTDI uninstaller program. Click "Continue" to run the
uninstaller or "Cancel" to exit.

FTDI Uninstaller A X|

If your USB device is connected, please unplug it now ...

Press Continue to uninstall the drivers, or Cancel to quit.

When the uninstaller has finished removing the device from the system, the caption on the "Cancel" button will
change to "Finish". Click "Finish" to complete the process.
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FTDI Uninstaller N X|

Uninstalling V¥ID_04034PID_6010

Deleting registry entries ...
Deleting files ...

Press Finish to exit.

Cantinue | Finish |
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Troubleshooting

1. Windows 2000 cannot find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the
INF files for the driver. The VID and PID programmed into

the device EEPROM may be found by using the USBView utility from the FTDI web site. These can then be
checked against the VID and PID entries in the driver INF files. If they do not match, that driver cannot be
installed for that device without either re-programming the device EEPROM or modifying the list of VID and
PID numbers in the INF files. Please note that only your own company VID and PID or FTDI's VID (0x0403)
and FTDI PID issued for use by your company should be used in the EEPROM and INF/INI files.

2. Windows 2000 forces a reboot after installing a device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy it.
This usually occurs with the FTD2XX.DLL file. Selecting

not to restart the computer then unplugging and re-plugging the device may allow the device to function
properly without restarting. Restarting the machine will allow the device to work correctly.

3. Driver installation fails and Windows 2000 gives error code 10

Windows error code 10 indicates a hardware error or failed driver installation. This

error may appear if a device has insufficient power to operate correctly (e.g. plugged into a bus powered hub
with other devices), or may indicate a more serious hardware problem. Also, it may be indicative of USB root
hub drivers being incorrectly installed. Please refer to the example schematics on the FTDI web site for
standard device configurations.
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Windows CE Installation Guide

Download the latest available drivers for the required processor model from the FTDI website and unzip them,
the critical files in the driver package are:

ftdi_ser.dll - the VCP driver file

FTDIPORT.inf - user changeable file to allow devices with custom VID and PID combinations to be installed

Copy all of the unzipped files to the \Windows directory on the PDA.

If the PDA requires a host adaptor (e.g. USB host cable, presentation pack or Compact Flash host card),
make sure that it is connected and installed before proceeding.

Connect the FTDI device to a host USB port on the PDA. This will provide a dialog box to direct Windows CE
to the driver files.

Type the full name of the VCP driver file into the dialog box as shown below. If the file name is incorrect, the
driver will not be found and the device will not function.

. Unidentified USB D «F #x 12:04

Sunday, June 01, 2003

Unidentified USB Devi(e

A Enter the name of the device
driver for this device. For

v| information, see the device
manufacturer's documentation,

12Y1[2(3[4(5]6(7]8]9]0]-|=
Tab[q[w[e[r[t[y[ulifo]p]IL
cap[a[s [a[faln]ik[T];]"
shift[z [x [c[v[b[n[m][, [.[/]
ctlaa] " [\] (4[]«

The device installation is now complete. The installation may be verified using the test program available form
the Utilities page of the FTDI website.
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Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e.
you have to repeat this installation procedure 2 times (2-port converter) or 4 times (for

4-port converter).
2. If you have any difficulties with the drivers we provided in this CD, you may download

the updated or appropriate versions from FTDI Web site
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)”.

31



http://www.ftdichip.com/

USB to RS-422 / RS-485 Adapter

Troubleshooting

1. "Unidentified USB Device" dialog is not displayed when device is
connected for the first time

If the "Unidentified USB Device" dialog is not displayed when the device is connected for the first time, it is
likely that the PDA does not have a USB host capability or that the host is not installed correctly.

Many PDAs require some form of adaptor (USB host cable, presentation pack or Compact Flash USB host
card) to provide the USB host capability that FTDI devices require.

2. "Error installing USB driver ftdi_d2xx.dll" message

The following installation error may be displayed for a number of reasons:

£ | unidentified USB D & x 10:36

(® sunday, June 01,2003
F=] Tap here to set owner information

D No upcoming appointments

ﬁUnidentified USB Device ok}
q Error installing USB driver
ftdi_d2xx

New Tools Accounts @ % g"

The driver name has been misspelt - The ".dII" file extension may be required for some platforms - The
required driver files are not in the \Windows directory - The driver file is in the wrong binary format
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3. "Error installing USB driver ftdi_ser.dll" message

The following installation error may be displayed for a number of reasons:

#1F| Unidentified USB D ¢ x 12:17

(® sunday, June 01, 2003
F=] Tap here to set owner information

D No upcoming appointments

& |nidentified USB Device (ok]
E
| Error installing USB driver

New Tools Accounts [ "= ﬂ|‘

The driver name has been miss pelt - The ".dllI" file extension may be required for some platforms - The
required driver files are not in the \\Windows directory - The driver file is in the wrong binary format

4. "Unidentified USB Device" appears each time the driver name is entered

This error can be caused when the VID and PID listed in the INF file does not match the VID and PID

combination programmed into the device. It can also be caused if the INF file has not been copied to the
\\Windows directory.
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i’j Unidentified USB D & «x 10:38 r’j \Unidentified USB D &7 «x 12:04

(¥ sunday, June 01, 2003 (® sunday, June 01, 2003

= Enter the name of the davice il ~ Enter the name of the device =
driver for this device. For driver for this device. For

v| Information, see the device information, see the device
manufacturer's docurnentation, Bl manufacturer’s documentation,

[ox ] [oncel | N ] [

1231(2(3(4(5|6(7|8(9|0|-|=|4 1231(2/3(4/5(6/7|8(9|0(- =4
Tabjq(wie|r|t|y|ulijop[[]] Tabjq[wle|rt|y|ulijo[p/[]]
caPla (s [dfffalhfjlk[r|:]"] caPla|s|d|ffafh|jfkir]:]"]
shift|z [x |[c|vib|n|m|, [|.[/]+ shift{z [x [clvibin|m|, |.|/]+
Ctijaa|* [\ ] [$[t]]~> Ctijaa|* |\ | [$[t]]~

- R

One way to check this is to use the Registry editor that comes with Embedded Visual C++ (or a suitable registry
editor on the Windows CE device itself) to check for the registry settings (Tools > Remote Registry Editor). With
ActiveSync running, connect to your device then look at the registry setting
KEY_LOCAL_MACHINE\Drivers\USB\LoadClients\
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iaix
Ragstry Ek Wew Cornection Hep
o e | 1 S 9 55 [
¥ B My Conputer A | Nare s
= 3 POCKET PC 2003 Dervice “_‘ﬂ’&rfwll {vahe rot set)
o1 0 MKEY_CLASSES ROCT
) () HKEY_CURRENT USER
=11 HKEY_LOCAL_MACHING
#* ] Comn
& ] CortroPared
=1 Grivers
3 ) Asive
< ] Eultln
+ ) Dusplay
3 1) PCMCIA
RIS B
3 ) SDCARD
& ) Toshioa
+ ] Uramodam
9 JusE
w ] ChentDerrers
(] FID1_DEVICE 6010

#] ) Defaut
#1357
4 Dsfaik
® () Explorer
* -] ExtMcdeare
% () MARDWARE
L) dert
—nt
(] Loxder
2wt
ks
] atfom
o et
+ ) Securky
% ) Services
+]5d
¥ () SCFTWARE
+-L Syetam
Lo 701

ATk

-

g

{POCKET BC 2000 Devica| LY _LOCAL_HACHING Drrver s{USE cadhenks\L027_2955C]
In this case, the entry is 1027_24592, which corresponds to a VID of 0x0403 (1027) and a PID of 0x6010
(24592) device. If this is not the device to be installed, the message will recur.

To solve the problem, the INF files must be edited to accommodate the required VID and PID. For the D2XX
drivers, edit the bold red entries in the following line in the ftd2xx.inf file:

[FtdiHw]
"FTDI Dual device"=FTDI,USB\&VID_0403&PID_6010

For the VCP drivers, edit the bold red entries in the following line in the FTDIPORT.inf:
[FtdiHw]
%VID_0403&PID_6010.DeviceDesc%=FtdiPort232,FTDIBUS\COMPORT&VID_0403&PID_6010

5. Device can write but cannot read

If the hardware does not work correctly under Windows 2000 or Windows XP then the problem is most
likely a hardware issue. Windows CE is not very tolerant of noisy hardware, so even "good" designs for
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Windows 2000 and XP may experience problems with Windows CE.

Another issue that has arisen with Windows CE is that different host devices support different bulk transfer
sizes. One method to attempt to resolve this is to reduce In Transfer Size to 64. This is the smallest possible
transfer size and will have a severe effect on performance, but should resolve most other issues. Larger
values may be tried to improve performance.

If a USB host CF card is being used, it may help to set the Raton bit in the configuration settings.

6. Bytes missing or data corrupt

This can occur when a host driver fails to send vendor commands properly which can result in the device
running at a different Baud rate to the one intended. The Baud rate can be verified easily by transferring data
from PDA/target to HyperTerminal.

Some host device drivers have been seen to lose packets of data which would also cause this problem.

7. Driver isn't sending or receiving any data
Sending and receiving data can be tested with an application such as VCPTest. However, this will not

highlight problems due to incorrect Baud rates. To check for the wrong Baud rate being set, try to
transfer data from the PDA/target to and from HyperTerminal.
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Windows XP Installation Guide

1. Installing Via The Found New Hardware Wizard

If a device of the same type has been installed on your machine before and the drivers that are about to be
installed are different from those installed already, the original drivers need to be uninstalled. Please refer to
the Uninstalling instruction.

Download the latest available drivers from the FTDI web site and unzip them to a location on your PC.

If you are running Windows XP or Windows XP SP 1, temporarily disconnect your PC from the Internet. This
can be done by either removing the network cable from your PC or by disabling your network card by going
to the "Control Panel\Network and Dial Up Connections", right clicking on the appropriate connection and
selecting "Disable" from the menu. The connection can be re enabled after the installation is complete. This
is not necessary under Windows XP SP 2 if configured to ask before connecting to Windows Update.
Windows XP SP 2 can have the settings for Windows Update changed through "Control Panel\System" then
select the "Hardware" tab and click "Windows Update".

Connect the device to a spare USB port on your PC. If the device is based on the FT2232, the Microsoft
composite device driver is automatically loaded in the background. Once the composite driver has been
installed Windows Found New Hardware Wizard will launch. If there is no available Internet connection or
Windows XP SP 2 is configured to ask before connecting to Windows Update, the screen shown in Figure
2.1 is displayed. Select "No, not this time" from the options available and then click "Next" to proceed with
the installation. If there is an available Internet connection, Windows XP will silently connect to the Windows
Update website and install any suitable driver it finds for the device in preference to the driver manually
selected.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard
Windows will search for current and updated software by

looking on your computer, on the hardware installation CD, or on
the Windows Update Web site (with your permission).

Online privacy information

Can Windows connect to Windows Update to search for
software?

O Yes, this time only
very time | connect a device

Click Next to continue.

[ Nest > ][ Cancel

Figure 2.1
Select "Install from a list or specific location (Advanced)" as shown in Figure 2.2 below and then click "Next".

Select "Search for the best driver in these locations" and enter the file path in the combo box ("C:\CDM
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2.02.04" in Figure 2.3 below) or browse to it by clicking the browse button. Once the file path has been
entered in the box, click next to proceed.

Found New Hardware Wizard

This wizard helps you install software for:

USB Serial Converter

') If your hardware came with an installation CD
&2 or floppy disk. insert it now.

‘What do you want the wizard to do?

O Install the software automatically (Recommended)
®i tion (Advanced}

alist or specit

Click Next to continue.

[ < Back ][ Next > ][ Cancel

Figure 2.2
Fuund Bew Hardware Wizard
Picaac chooae your search and inztallabon oplions "
~. ’

(%) Search for the bact divar i thasa lacalions

Use f9a chack bawas below 2 It o espand the dafaut sasch, which roudas bacal
pydu andremavable meda Tha best diver lourd ke nilaled

1 Smmch ssmoreants mecis Foope. COAIOM.. |
Fllrcuds iz kcatoninthe saarch
|ZACDM 20204 v| b Eroves |
) Boet s |l chomss e i Lo

Chonse i oplon to seleet the doace duver hiom a kst wWincoss docs rot quaraies thel
the cimer gau enacae wll 5e the Best nack loe pour acwas

< Back I[ Huqr > || Cancel

Figure 2.3

If Windows XP is configured to warn when unsigned (non WHQL certified) drivers are about to be installed,
the message dialogue shown in Figure 2.4 will be displayed unless installing a Microsoft WHQL certified
driver. Click on "Continue Anyway" to continue with the installation. If Windows XP is configured to ignore file

signature warnings, no message will appear.

The screen shown in Figure 2.5 will be displayed as Windows XP copies the required driver files.
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Hardware Installation

|} E The software you are installing for this hardware:
L
USE Serial Converter

has not passed Windows Logo testing to verify its compatibility with

this version of Windows. [Tell me why this testing is important)

Continuing your installation of this software may impair
or destabilize the correct operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

[ Continue Anyway ] [ STOP Installation |

Figure 2.4

Found New Hardware Wizard

Please wait while the wizard installs the software...

Y/
{/

Q USE Serial Converter

e, £

ftd2sx.dll

To CAWINDOWS system32

(CCCCTCCTCTCCT T )
Figure 2.5

Windows should then display a message indicating that the installation was successful (Figure 2.6). Click
"Finish" to complete the installation for the first port of the device.

The Found New Hardware Wizard will launch automatically to install the COM port emulation drivers. As
above, select "No, not this time" From the options and click "Next" to proceed with the installation (Figure
2.7).

39




USB to RS-422 / RS-485 Adapter

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished installing the software for:

% USE Serial Converter

Click Finish to close the wizard.

~ Finish

Figure 2.6

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

‘Windows will search for current and updated software by
looking on your computer, on the hardware installation CD, or on
the Windows Update Web site (with your permission).

Online privacy information

Can Windows connect to Windows Update to search for
software?

O Yes, this time only
oY
(O]

d every time | connect a device

Click Next to continue.

[ Next > ][ Cancel ]

Figure 2.7

Select "Install from a list or specific location (Advanced)" as shown in Figure 2.8 below and then click "Next".

Select "Search for the best driver in these locations" and enter the file path in the combo box ("C:\CDM
2.02.04" in figure 2.9 below) or browse to it by clicking the browse button. Once the file path has been

entered in the box, click next to proceed.
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Found New Hardware Wizard

This wizard helps you install software for:

USB Serial Port

r') If your hardware came with an installation CD
&2 or floppy disk. insert it now.

‘What do you want the wizard to do?

O Install the software automatically (Recommended)

Click Next to continue.

[ < Back ][ Next > ][ Cancel ]

Figure 2.8

Found New Hardware Wizard

Please choose your search and installation options. \

&

Use the check boxes below to limit or expand the default search, which includes local
paths and removable media. The best driver found will be installed.

[[] Search removable media (floppy, CD-ROM...)

Include this location in the search:

C:ACDM 2.02.04 v

(O Don't search. | will choose the driver ta install.

Choose this option to select the device driver from a list. Windows does not guarantee that
the driver you choose will be the best match for your hardware.

[ < Back ][ Next > ][ Cancel

Figure 2.9

If Windows XP is configured to warn when unsigned (non WHQL certified) drivers are about to be installed,
the message dialogue shown in Figure 2.10 will be displayed unless installing a Microsoft WHQL certified
driver. Click on "Continue Anyway" to continue with the installation. If Windows XP is configured to ignore file

signature warnings, no message will appear.

The screen shown in Figure 2.11 will be displayed as Windows XP copies the required driver files.
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Hardware Installation

1] E The software you are installing for this hardware:
.
USE Serial Port

has not passed Windows Logo testing to verify its compatibility with

this version of Windows. [Tell me why this testing is important]

Continuing your installation of this software may impair
or destabilize the correct operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

[ Continue Anyway J | STOP Installation |

Figure 2.10

Found New Hardware Wizard

Please wait while the wizard installs the software...

Y/
{/

5,‘ USE Serial Port
-

e, T B

ftseri2.dil

To C:AWINDOWS system32

(FESEERR R R NR R RR R NRR R R RS )
Figure 2.11

Windows should then display a message indicating that the installation was successful (Figure 2.12). Click
"Finish" to complete the installation for the first port of the device.

Open the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click
"Device Manger") and select "View > Devices by Connection", the device appears as a "USB Serial
Converter" with an additional COM port with the label "USB Serial Port" (Figure 2.13).
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Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished installing the software for:

USE Serial Port

Click Finish to close the wizard.

Figure 2.12

Device Manager

File Action Yiew Help

& 2mE &

'¢ ACPI Fixed Feature Button A
#® Genuine Intel(R) CPU 2160 @ 1.80GHz [
#® Genuine Intel(R) CPU 2160 @ 1.80GHz

= % PCIbus

+ é Intel(R) 946GZ Express Chipset Family
- 1§ Intel(R) 82801 PCI Bridge - 244E
¢ Intel{R) 82801G (ICH7 Family) SMBus Controller - 27D4
& Intel{R) 82801G (ICH7 Family) USE Universal Host Controller - 27C8
= Intel{R) 82801G (ICH7 Family) USE Universal Host Controller - 27C9

. ¥T05E Universal Host Controller - 27CA
Intel{R) 82801G (ICH7 Family) USE Universal Host Controller - 27CB
Intel(R) §2801G (ICH7 Family) USB2 Enhanced Host Controller - 27CC

_{ Intel(R) 82801GB{GR (ICH7 Family) LPC Interface Controller - 2768
) Intel(R) 82801GB{GR/GH (ICH7 Family) Serial ATA Storage Controller - 27C0

_J Intel{R) 946GZPLIGL PCI Express Root Port - 2971

K j Intel{R) 946GZPL/GL Pracessor ta IJO Controller - 2970

j Microsoft UAA Bus Driver for High Definition Audio

¢ Motherboard resources v

F

+

Figure 2.13
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£ Device Manager. Q@@

File Action View Help
& a

=l g PCIbus ~
+ 3‘ Intel(R) 946GZ Express Chipset Family
+ j Intel{R) 82801 PCI Bridge - 244E
Intel(R) 82801G (ICH7 Family) SMBus Controller - 27DA
+ Intel(R) 82801G (ICH7 Family) USB Universal Host Controller - 27C8
+ Intel(R) 82801G (ICH7 Family) USB Universal Host Controller - 27C9

Intel{R) 52801G (ICH7 Family) USE Universal Host Controller - 27CA
- 6% USB oot Hub
¥ USB Composite Device
= Q USB Serial Converter A
7 USB Serial Port (COM3)
=8 USB Serial Converter B
7 USB Serial Port (COM4)
3 Intel{R) Bzamts el 3B Tniversal Host Controller - 27CB
+ Intel{R) 82801G (ICH7 Family) USB2 Enhanced Host Controller - 27CC
+ _{ Intel(R) 82801GB{GR {ICH7 Family) LPC Interface Controller - 2768
+-=) Intel(R) 52501GB{GR{GH (ICH7 Family) Serial ATA Storage Controller - 27C0
_J Intel(R) 946GZ/PL/GL PCI Express Root Port - 2971
_é Intel{R) 946GZPL/GL Pracessor ta IJO Controller - 2970
& j Microsoft UAA Bus Driver for High Definition Audio
¢ Motherboard resources v

Figure 2.14

2. Installing Using DPInst

In the case of a Microsoft WHQL certified driver package, it is possible to preinstall the driver package using
the Microsoft Driver Install Frameworks (DIFx) tools. The simplest tool provided is the Driver Package
Installer (DPInst). When placed in the same directory as the INF files for the driver package, simply run
DPInst.exe and the certified driver package will be installed on the machine.

The current driver package supports 32bit and 64bit systems through common INF files. DPInst has
separate executables for 32bit and 64bit installation. This means that if a single solution is desired for 32bit
and 64bit systems, the developer must be able to detect which version of DPInst is required for the system
the driver is being installed on.

For more information on DPInst, see the FTDI Windows Driver Installation application note.

3. Installing From Windows Update

If a certified driver is available for the target operating system, it is possible to install the driver from the
Windows Update web site.

Directions to install the driver from Windows Update are very similar to those outlined in 2.1 Installing Via
The New Hardware Wizard, except that the “Yes, this time only” or “Yes, now and every time | connect a
device” option should be selected on the first screen of the wizard when asked if Windows Update should be
checked for a driver. If the wizard finds a matching driver on Windows Update, the driver will be
automatically downloaded and installed for the device.
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Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e.
you have to repeat this installation procedure 2 times (2-port converter) or 4 times (for
4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download
the updated or appropriate versions from FTDI Web site
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)”.
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Uninstalling Instruction

Consequently, a new method for uninstalling has to be used. Devices can be removed using the Device
Manager by simply right clicking on the device and selecting "Uninstall". This will delete the associated
registry entries for that device only.

Under Windows XP, driver files and OEM INF and PNF files must be removed manually or by using a
custom application. OEM INF and PNF files are located in the Windows\Inf directory and can be identified by
searching for a VID and PID string matching the device installed e.g. VID_0403&PID_6001. Once the
matching OEM INF files are found (e.g. oem10.inf for FTDIBUS.INF and oem11.inf for FTDIPORT.INF), the
corresponding PNF files must also be removed (e.g. oem10.pnf and oem11.pnf). Driver files are located in
the Windows\System32 and Windows\System32\Drivers directories.

Some points to note about this uninstallation method:

If the VCP driver has been installed, the COM port driver should be removed before the bus driver. If the bus
is removed first, the COM port will no longer appear in the Device Manager.

If the driver files are deleted while other installed devices still require them those devices will not work
correctly. This can be fixed by right clicking the device and selecting "Reinstall Driver" which will replace the
missing files.

If a device to be uninstalled is not connected to the PC, the device can still be removed by setting the device
manager to show phantom devices. This can also allow a virtual COM port to be uninstalled if the bus layer
has been removed first. Instructions on how to display phantom devices are given in the Advanced Driver
Options application note.
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Troubleshooting

1. Windows XP cannot find Drivers for My Device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in
the INF files for the driver. The VID and PID programmed into the device EEPROM may be found by using
the USB View utility from the FTDI web site. These can then be checked against the VID and PID entries in
the driver INF files. If they do not match, that driver cannot be installed for that device without either re-
programming the device EEPROM or modifying the list of VID and PID numbers in the INF files.

Please note that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use
by your company should be used in the EEPROM and INF/INI files.

End customers should obtain modified drivers from the OEM of the device, and not necessarily edit the files
themselves.

2. Windows XP Forces a Reboot after Installing a Device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying
to copy it. This usually occurs with the FTD2XX.DLL file. Selecting not to restart the computer then
unplugging and re-plug the device may allow the device to function properly without restarting.
Restarting the machine will allow the device to work correctly.

3. Driver Installation Fails and Windows XP Gives Error Code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a
device has insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices),
or may indicate a more serious hardware problem. Also, it may be indicative of USB root hub drivers being
incorrectly installed.

Please refer to the example schematics on the FTDI web site for standard device configurations. If the error
persists, please contact the FTDI support department.

4. Windows XP Displays An Error And Then Terminates Installation

If the following screen is displayed with this message, Windows XP has been configured to block the
installation of any drivers that are not WHQL certified.
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Hardware Installation

6 The software you are nstalling for this hardware
USB Senal Converter

has not paszzed Windows Logo testing to verify itz compatibiity
with this version of Windows. [T ell me why this testing is important]

This hardware will not be installed Contact pours system
admirustrator.

ok ]

Figure 4.1

Two options are available to successfully install the device. Either a certified version of the driver can be
installed (if available) or the driver signing options can be changed to either warn or ignore to allow the
installation to complete.

To change the current driver signing setting, go to "Control Panel\System", click on the "Hardware" tab and
then click "Driver Signing". The desired signing option may then be selected.
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Windows VISTA (Win 7, 8, 8.1, 10, 11) Installation Guide

Connect the device to a spare USB port on your PC.

If there is an available Internet connection, Windows VISTA (Win 7, 8, 8.1, 10, 11) will silently connect to the
Windows Update website and install any suitable driver it finds for the device in preference to the driver
manually selected. If no suitable driver is automatically found then the following procedure should be followed.

L s

Windows needs to install driver software for your TTL232R
Tester

@ Locate and install driver software (recommended)

Windows will guide you threugh the process of installing driver software
for your device.

2 Ask me again later
Windows will ask again the next time you plug in your device or log on.

& Don’t show this message again for this device
Your device will not function until you install driver software.

Cancel

When locate and install driver software (recommended)" is selected the following screen will appear. Note: the
text “TTL Tester” is replaced with the description of the customer hardware.
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() L Found New Hardware - TTL232R Tester

Insert the disc that came with your TTL232R Tester

If you have the disc that came with your device, insert it now. Windows will automatically
search the disc for driver software.

< Idon't have the disc. Show me other options.

Select “I don’t have the disk. Show me other options” The next screen will appear.

[

KJ . Found New Hardware - TTLR Tester

Windows couldn’t find driver software for your device

® Check for a solution
Windows will check to see if there are steps you can take to get your device
working,

* Browse my computer for driver software (advanced)
Locate and install driver software manually.
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. The next screen will appear.

Select “Browse my computer for driver software (advanced

K3 L Found New Hardware - TTL232R Tester
Browse for driver software on your computer

Search for driver software in this location:

C:\Users) | Desktop\CDM 2.00.00 (Certified)

IV Include subfolders

LNext J [ Cancel J

Browse to the folder where the CDM driver has been stored (when uncompressed) and press “Next”

The example shown above uses a folder on the desktop.

The next screen will appear.

) = FoundNew Hardware - TTL232R Tester

Installing driver software..

This screen will automatically complete and then change to the one below:
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U [l Found New Hardware - USB Serial Converter

The software for this device has been successfully installed

Windows has finished installing the driver software for this device:

USB Serial Converter

The bus layer of the driver is now installed.

After the driver is installed it is important to determine which COM port has been assigned to the device for
configuring the application that will use the device.

Open the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click
"Device Manager") and select "View > Devices by Connection”, the device appears as a" USB Serial
Converter" with an additional COM port with the label "USB Serial Port".
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2 Device Manager
File Action View Help

L Aol 7 Bk

EE=

- ali'rllﬁii

« & Computer

v ¢y Disk drives

v By, Display adapters

7 g DVD/CD-ROM drives
=4 Floppy disk drives

}

= o Floppy drive controllers

& !;‘F; Human Interface Devices

L4 IDE ATA/ATAP] controllers

i @ [IEEE 1334 Bus host controllers

== Keyboards

0 _ﬂ Mice and other pointing devices

5 & Monitors

- &% Network adapters

5 I Portable Devices

=" Ports (COM & LPT)
T=T Communications Port (COML)
"7 Printer Port (LPT1)
"7 USB Senal Port (COM3)

7 [&) Processors

= % Sound, video and game controllers
&, High Definition Audio Device

= &> Storage controllers

=

£ K System devices
= § Universal Serial Bus controllers

This screen shows the device connected to COMS.

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e.
you have to repeat this installation procedure 2 times (2-port converter) or 4 times (for
4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download
the updated or appropriate versions from FTDI Web site
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)”".
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Uninstalling Instruction

With the release of Microsoft Windows Vista, the FTDI uninstaller has been rendered unusable due to Windows
Resource Protection preventing the executable from deleting driver files and associated registry values. Vista
will only allow the system itself to modify files and registry values in these locations.

Consequently, a new method for uninstalling is required. Devices can be removed using the Device
Manager by simply right clicking on the mouse and selecting "Uninstall". This will delete the
associated registry entries for that device only. Vista provides an automatic method to delete driver
files via a check box to :'Delete the driver software for this device" on the uninstall dialog box.

Confirm Device Uninstall -

USB Senal Converter

Waming: You are about to uninstall this device from your system.

|| Delete the driver software for fis device.

Windows 2000, XP and Server 2003 do not have this check box, so driver files and OEM INF and PNF
files must be removed manually or by using a custom application.

Some points to note about the new uninstallation method:

If the VCP driver has been installed, the COM port driver should be uninstalled before the bus driver. If the bus
is removed first, the COM port will no longer appear in the Device Manager.

If the files are deleted while other installed devices still require them those devices will not work correctly. This
can be fixed by right clicking the device and selecting "Reinstall Driver" which will replace the missing files.

If a device to be uninstalled is not connected to the PC, the device can still be removed by setting the device

manager to show phantom devices. This also allows a virtual COM port to be uninstalled if the bus layer has
been removed first.
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Troubleshooting

1. Windows VISTA (Win 7, 8, 8.1, 10, 11) can not find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the
INF files for the driver. The VID and PID programmed into the device EEPROM may be found by using the USB
View utility from the FTDI web site. These can then be checked against the VID and PID entries in the driver
INF files. If they do not match, that driver cannot be installed for that device without either reprogramming the
device EEPROM or modifying the list of VID and PID numbers in the INF files. Please note that only your own
company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by the customer should be used in
the EEPROM and INF files.

End customers should obtain modified drivers from the OEM of the device, and not necessarily edit the files
themselves.

2. Devices not shown in Device Manager for uninstalling

Devices that have been installed on a system but are not currently available are referred to as "phantom
devices". These devices are not usually displayed in the device manager, but can be made to be displayed as
though they are attached. This allows device properties to be changed or devices to be uninstalled via Device
Manger even though the device is not physically connected to the PC.

To display phantom devices in Device Manager, a new system variable is required. Open "Control Panel
> System" then select the "Advanced" tab and click "Environment Variables". In the System Variables
section (NOT THE USER VARIABLES SECTION), click "New..." to display the following window:

Edit System Variable [
Variable name: DevMar_Show_NonPresent_Devices
Variable value: f
OK ‘ Cancel

Create a new System Variable called "DevMgr_Show_NonPresent_Devices" and set the value to 1,
then click OK.

Open the Device Manager ("Control Panel > System" then select the "Hardware" tab and click "Device
Manager...", or "Control Panel > Device Manger" in Vista) and select "View > Show Hidden Devices".
Device Manager will then show all hidden and phantom devices available on that PC as shaded.

3. Windows Vista (Win 7, 8, 8.1, 10) shows a warning that the driver is not certified
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If the driver is not certified then a pop up window such as shown below will be displayed.

&) Windows Security

@ Windows can't verify the publisher of this driver software

«» Don't install this driver software
You should check your manufacturer's webske for updated driver software For yvour
device.

«» Install this driver software anyway
Only instak driver software obtained from your manufacturer's website or disc.
Unsigned software from other sources may harm your computer or steal information.

:_] See detais

If you are certain of the source of the driver the warning can be ignored and you can continue
installation by selecting “Install this driver software anyway”.

4. Driver will not install on VISTA x64

VISTA x64 OS will only allow certified drivers to be installed. The certified driver supplied by FTDI will work with
VID 0403 and PID 6001 for FT232 and FT245 devices.

If you have a product where the manufacture has customized the driver but has not recertified it, then the driver
will not load. You should contact your vendor to determine if they will support VISTA x64.
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MAC OS X Installation Guide

Download the driver from the VCP Drivers section of the FTDI web site and save it to the hard disk. The driver
is now available in disk image (.dmg) format. Run the installer by double clicking on the
FTDIUSBSerialDriver.dmg icon.

ze_ Of“ Install FTDIUSBSerialDriver Kernel Extension

" | Welcome to the Mac OS X Installation Program. You will be
© Introduction guided through the steps necessary to install this software.

® Rexd Me

Welcome to the FTDIUSBSerialDriver Kernel Extension Installer

® Select Destination
® Installation Type
® Installing

® Finish Up A

h

g

Go Back { Continue |

Click Continue to proceed with the installation and follow the instructions on screen.

When the installation is complete, reboot the computer.
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rQ 0.0 Install FTDIUSBSerialDriver Kernel Extension i

Install Software

‘ | 1

© Introduction
© Read Me
© Select Destination

© Installation Type
© Installing The software was successfully installed

Click Restart to finish installing the software.

_

When the computer has rebooted, plug in the device. If the device is installed properly, you will see entries
in the /dev directory:

/dev/cu.usbserial-xxxxxxxx
/dev/tty.usbserial-xxXxXxxxxx

Where xxxxxxxx is either the device's serial number or, for unserialized devices, a location string that depends
on which USB port your device is connected to. The Terminal application can be launched by selecting Go >
Applications > Utilities > Terminal. Type the following lines in the Terminal window to produce the file list:

cd /dev
Is-I

If you run the application System Preferences and select Network (Go > Applications > System
Preferences > Network), you should see the text "New Port Detected".

58




USB to RS-422 / RS-485 Adapter

2 New Port Detected
i} ‘ A new network port has been detected:

usbserial-1B22

Please verify that it is configured correctly, then

press Apply Now to activate i-.

Click OK and select Network Port Configurations from the show list. The new port can be enabled from this
screen by checking the on box and clicking Apply Now.

"® 6N Network [ )

« |y O

Show All | Displays Sound Network Startup Disk

Location: | Automatic m

Show: ' Network Port Configurations m

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

On | Port Configurations

B usbserial-1B22

E Internal Modem

g Built-in Ethernet
( Delete... )
[ Duplicate )

:

New...

@

{
d Click the lock to prevent further changes. ( Assistme... ) ( Apply Now )
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At this point, it is possible to exit Network and use the device as a COM port. If you
wish to set the device up a modem for an Internet connection, select the new port from

the Show list to display the window below.

r = al
e 6N Network ()
« = A G A
Show All Displays Sound Network Startup Disk

Location: Automatic f :‘]
Show: wusbserial-1822 m
L PPP . TCP/IP  Proxies Modem
Service Provider: (Optional)
Account Name:
Password:
Telephone Number:
Alternate Number: (Optional)

"1 Save password

Checking 11is box allows all users of this computer to
access this Internet account without entering a password.

( PPP Options... ) ( Dial Now... )

©)

) .

Jfﬂ Click the lock to prevent further changes. { Assistme... ) Apply Now

Entries for this screen are specific to the Internet account for each user. If you do not know the required details,
contact your Internet service provide

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e.

you have to repeat this installation procedure 2 times (2-port converter) or 4 times (for
4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download
the updated or appropriate versions from FTDI Web site
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)”".
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Uninstalling instruction

To remove the drivers from Mac OS X, the user must be logged on as root. Root is a reserved username that
has the privileges required to access all files.

Start a Terminal session (Go > Applications > Utilities > Terminal) and enter the following commands at the
command prompt:

cd /System/Library/Extensions

rm -r FTDIUSBSerialDriver.kext

cd /Library/Receipts

rm -r FTDIUSBSerialDriver.kext

The driver will then be removed from the system.

To remove the port from the system, run the application System Preferences and select Network. Selecting
Network Port Configurations from the Show menu will display the port as greyed out. Select the uninstalled
port and click Delete. Confirm the deletion to remove the port.

.

r ==
®6n Network =)
C—
« @ Q6 =2
Show All Displavs Sound Network Startup Disk
Location: = Automatic '3‘]

Show: Network Port Configurations ﬂ

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

On  Port Configurations
5 jshserial-182: —_—
# Internal Modem (__New.. )
™  Built-in Ethernet ( Edit :-,

(\n Delete... )

Duplicate

()

,1 S
'} 4‘ Click the lock to prevent further changes. ( Assistme... ) Apply Now
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Troubleshooting

1. How do | know what my device ID is?

Launch the System Profiler utility, or Apple System Profiler for earlier versions of OS X. This can be
accessed by going to the Finder and selecting Applications from the Go menu, then open the Utilities folder.
Select USB under Hardware in the pane to the left and then select the appropriate device from the USB
Device Tree. In the screen shot below (from OS 10.3), the device has a device ID given by:

Vendor Name: FTDI

Product ID: 24577 ($6001)

A Vendor Name of FTDI is equivalent to a Vendor ID of 1027 ($0403).

‘@06 System Profile )
Andy's eMac 10/01/2005 08:37
Contents USB Device Tree
¥ Hardware USB Bus
Memory W USB Bus
PCI/AGP Cards ¥ Hub in Apple Extended USB Keyboard
ATA
SCSI Apple Optical USB Mouse
USB Apple Exterded USB Keyboard
FireWire USB Bus
AirPart Card USB High-Speed Eus
Modems
¥ Software
Applicatiors
Pigasions USE <-> Serial: :
Network
Logs ~ Vendor Name FIDI
Speed: Up 10 12 Mb/sec
Product iD 24577 (36001)

Bus Power (mA): 100

If the device does not work after installing the driver, it is likely to be because the PID is not supported by the
driver. If this is the case, contact FTDI Support with the PID that needs to be added to the driver. If the VID is
not 0x0403, it is likely that the device is not an FTDI device and we cannot support it.

62




USB to RS-422 / RS-485 Adapter

2. The device does not appear in the /dev directory or the text "New Port
Detected"” is not displayed in System Preferences-Network

FTDI USBSeria Driver does not support your device ID (VID and PID). Disable the EEPROM so that
the device reverts to its default device ID, then replug. To get support for your device ID built into
FTDI USBSerial Driver, contact FTDI quoting your device ID and a description of your device.

3. The device cannot be accessed even though the device ID is Supported
in FTDI USBSerial Driver

An ownership or permissions problem is preventing the system from making the device accessible.
Check that the driver is owned by root and wheel. The most common symptom is the group for FTDI
USBSerial Driver is not wheel. To change the group, login as root and perform the following script in
a Terminal window (Go > Applications > Utilities > Terminal):

cd /system/library/extensions

chgrp -R wheel FTDIUSBSerialDriver.kext

Reboot for the change to take effect.
4. How do | open a Terminal window?

A Terminal window can be started by selecting Go > Applications > Utilities > Terminal .The terminal
window is equivalent to a DOS prompt in Windows.

63




USB to RS-422 / RS-485 Adapter

Regulatory Compliance

Disclaimer

Information in this document is subject to change without notice. The manufacturer does not make any representations or
warranties (implied or otherwise) regarding the accuracy and completeness of this document and shall in no event be
liable for any loss of profit or any other commercial damage, including but not limited to special, incidental, consequential,
or other damages.

No part of this document may be reproduced or transmitted in any form by any means, electronic or mechanical,
including photocopying, recording or information recording and retrieval systems without the express written permission
of the manufacturer.

All brand names and product names used in this document are trademarks, or registered trademarks of their respective
holders.

CE Certification
This equipment complies with the requirements relating to electromagnetic compatibility.
It has been manufactured under the scope of RoOHS compliance.

FCC Compliance Statement

This equipment generates and uses radio frequency and may cause interference to radio and television reception if not
installed and used properly. This equipment has been tested and found to comply with the limits of a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation.

You are cautioned that changes or modification not expressly approved by the party responsible for compliance could
void your authority to operate the equipment.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and

(2) This device must accept any interference received, including interference that may cause undesired operation

ﬁ WEEE (Waste of Electrical and Electronic Equipment),
Recycling of Electronic Products

In 2006 the European Union introduced regulations (WEEE) for the collection and recycling of all waste electrical and
electronic equipment. It is no longer allowable to simply throw away electrical and electronic equipment. Instead, these
products must enter the recycling process.

Each individual EU member state has implemented the WEEE regulations into national law in slightly different ways.
Please follow your national law when you want to dispose or any electrical or electronic products. More details can be
obtained from your national WEEE recycling agency.
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